BOOSTSPEED 13
User Manual

Welcome to Auslogics BoostSpeed 13
Improve your computer’s performance

Prevent sudden glitches and crashes

Clean and optimize your hard drive

Protect your online privacy and a lot more
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Installing BoostSpeed 13

Select the interface language from the
drop-down list at the top-right.
Launch the installer by double-clicking
on the downloaded file.

Click the links to review the EULA
and Privacy Policy.
Click the ‘Agree and install’ button to
Auslogics BoostSpeed 13

start installation.

Review and check or uncheck
additional options.
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Make sure the checkbox to launch

BoostSpeed is checked and click the

Aus lo gic s B o o s t S p e e d 1 3

‘Finish’ button to complete installation.
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Free vs Pro

FREE

PRO

Essential PC cleanup & optimization

BoostSpeed comes in two versions: Free and
Pro. The Free version offers basic functionality
for cleaning your PC and improving its
performance. The Pro version provides a
multitude of advanced features that let you
take full control of your PC’s functioning. This
table should give you an idea of what you can
expect from each version.

Advanced PC cleanup & optimization
Manual Internet optimization
Automatic Internet optimization for an ultimate connection speed boost
Basic privacy protection
Advanced privacy protection for all data stored on your PC
Browser Anti-Tracker to protect your online privacy
Menu Manager

PRO

Add-ons Manager

hen using the Free version, you will see all
Pro features marked with the yellow PRO tag.
This should give you a good idea of what you
can get if you upgrade. The rest of this manual
will talk about both Free and Pro version
features in more detail.

W

Basic registry cleanup
Full registry cleanup
Basic junk cleanup to free up disk space
Auslogics BoostSpeed 13

Advanced disk cleanup options to maximize available space
Disk defragmentation to speed up data access
Intelligent Defrag to optimize file placement on drives for an even bigger speed boost

Purchase BoostSpeed Pro

Scheduled disk defragmentation to maintain drive health
Scheduler for effortless regular scans and maintenance
Ask a Question option for live expert answers at a click of a button (1 question in free version)
nlimited use of all advanced PC tools

U

Customize notification settings

1 question

3 questions
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Registering BoostSpeed Pro
To unlock and use all of the Pro features, you need to upgrade your BoostSpeed Free to the Pro version. Here is how to do that:

Click the ‘Activate Pro Version’ button at the bottom-right of the program window. This will bring
up a small window with a field to enter your key in.

If you’ve already purchased a license and received a license key via email, copy your key from the
confirmation email. Then, go back to BoostSpeed, paste the key into the registration field and
click ‘Register’.
Don’t have a license yet? Click the ‘Get a license key’ link below the registration field to go to a
web page where you can purchase a license.

Auslogics BoostSpeed 13

NOTE

When you place your order online and complete payment, a confirmation message is sent to
you via email to the address you provide during checkout. You will be getting two messages: one
containing your invoice and the other with your license information. If you don’t see the
message(s), please check your spam/junk mail folder before contacting technical support. A
common reason for not receiving an order confirmation is typos made in the email address, so
be sure to double-check your contact info when placing order.
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Backing up with the Rescue Center
Auslogics BoostSpeed is equipped with the Rescue Center, which lets you create a backup prior to running optimization or any other operations. This helps ensure that you can
always roll back any changes made by Auslogics tools if you do not like the results.

We recommend getting familiar with the

In the Settings window that opens, scroll

Rescue Center prior to using BoostSpeed for

down to the bottom of the left-side

the first time. You can specify which parts of

navigation pane and click on ‘Rescue Center’.

the BoostSpeed package should back up

This will open the current Rescue Center

before each run, how long those backups

settings and let you change any of them

should be stored and how much disk space

according to your preferences. If you’d like, you

they may occupy.

can have most tools create backups as you
first start using BoostSpeed and then uncheck
them as you get more comfortable with the

Auslogics BoostSpeed 13

program.

To access the Rescue Center settings,
click on the gear icon at the bottomright of the program window.
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To view backups created in the Rescue
Center, click on the diskette icon at the
bottom-right of the main program
window.
In the window that opens you will
see a list of available backups that
have been created by BoostSpeed.
Select a backup from the list and
then choose the action you would
like to apply to it by clicking a button
above the list, such as ‘Restore’,
‘Details’ or ‘Delete’. Clicking ‘Refresh’
will refresh the list of available
backups. Click ‘OK’ when done.

You can also view available system
restore points here by selecting ‘Restore
Points’ from the left-side menu. Use this
feature if you need to take your whole
system back to a point in time before
you applied specific changes or installed
certain software, not just Auslogics.

NOTE

When you use a restore point, under certain circumstances, you may lose all changes made and all files saved after the date to which you are rolling back.
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Where to Start?
When you launch BoostSpeed for the first time, you will have no
doubt as to what to do first. Just click the big button in the middle
of the screen to run your first scan.
To the right of the Scan button, you see the gear icon taking you to
the ‘Customize scan’ option where you can choose sections to
scan or ignore, if needed. Clicking it is optional.

Auslogics BoostSpeed 13

To the top-right of the Scan button you see the mode switch that
lets you easily switch to Advanced mode, if you feel that you want
more control and more options at hand. By default, BoostSpeed
launches in Basic mode for the first time. You can also switch
modes by going to the View menu at the top-left. See more
information on the two modes further in this guide.
Here you will also find 6 of the most useful tools listed below the
Scan button. Clicking the three dots at the top-right of each tool
tile will bring up options to remove the tile or replace it with
another tool. (More information about these tools is provided
further in this guide)
On the right, see the quick links to more recommended features
that will help improve your PC even further.
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Top Menu

Auslogics BoostSpeed 13

The main program menu is located at the very top of the program window and gives you four drop-down lists of shortcuts to almost every BoostSpeed feature.

The View menu lets you switch
between Basic and Advanced modes,
switch interface skins or set
BoostSpeed’s interface to its default
appearance.

The File menu contains the main options that let you quickly run any program or
open a website by simply typing its name or address in a popup window, open the
Control Panel, run a scan, schedule maintenance, open the Rescue Center,
settings or check for updates.

The Tools menu gives you quick access to all tools included in
BoostSpeed, as well as some additional Auslogics software that you
may install.

The Help menu lists the options you
have for getting information about the
program or assistance with it.
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Program Modes: Basic Mode

Auslogics BoostSpeed 13

BoostSpeed comes with two modes that are meant to accommodate users of any IT experience level.

The Basic mode minimizes the amount of thought or effort required of the user to run
maintenance: the screen has a big button in the center with just the essential tabs and
tools along the window edges. All you need to do is click the Scan button to launch a
comprehensive checkup of your Windows system.

While the scan is running, you can stop or pause it, see the progress right below the
button or click on ‘See scan details’ to see the categories and specific items being
processed along with the number of actionable items found.

Auslogics BoostSpeed 13
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When the scan completes, you can just click the Resolve All button on the
Dashboard, or click on ‘See full report’ to switch to the My Scanner tab.

On the My Scanner tab, review all detected items under each of the seven
categories, and decide if you want the cleanup to ignore any of them. You can click
on the category names on the left to switch between them, click the ‘See report
and customize’ link next to each category for a more detailed view, and uncheck
any of the detected items or subcategories, if you like. When done reviewing, click
the ‘Resolve Selected’ button at the bottom to launch repair.
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Tabs in Basic Mode

Auslogics BoostSpeed 13

In Basic mode, you see the most essential tabs at the top.

My Advisor, where you can see recommendations for
what needs to be done at the moment.

Ask a Question, where you can get expert answers to your
PC-related questions, as well as find other ways to get
help.

All Tools, where you can see a full list of all tools included
in BoostSpeed split into categories, so you can easily find
the tool you need.

To Contents
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Bottom panel
Below the main window is a collection of the most useful tools for everyday tasks.

You can remove or replace tools as you like to create a custom toolkit you’ll always have at hand. To
do that, click the three dots at the top-right of any tool tile.

Menu Manager


Cat Mode


This tool lets you customize the context
menu (the right-click menu) for many
Windows elements, including files, folders,
drives, the Recycle Bin, etc. You can review
the menu’s current appearance, then
choose to add or remove options as you
like.

Auslogics BoostSpeed 13

This handy tool locks your PC’s keyboard
and mouse when you step away, so that
your pet can’t do damage to your system
or data. When you return, you will need to
enter a pass code to unlock your PC. You
can set the pass code and activation delay
in mode settings.

Add-ons Manager


The tool lets you sort through and disable
browser and application add-ons, and shell
extensions. Clicking on this tile will open Addons Manager in a new tab and display a list of
all installed add-ons. You can review each addon’s trust rating, info about the maker and
other details. Click the toggle in front of each
add-on’s name to turn it on or off.

Disk Defrag


Winner of multiple industry awards, Auslogics
Disk Defrag is an essential tool that lets you
defragment hard drives, optimize SSDs and
offers a number of other features to help
ensure top data access speed.

Multi Uninstall Manager


The tool lets you go through all software
installed on your PC, select unneeded
programs and uninstall them all in one click
instead of manually going through them one
by one. Multi Uninstall Manager will queue the
apps for removal and safely remove them one
at a time.

Startup Manager


This tool handles the common cause of slow
PC bootup. It lets you review the apps set to
run on Windows startup, and cut the list down
to the bare minimum, which can effectively
speed up system loading. The tool opens in a
new tab.
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Right-Side Panel
The right-side panel in Basic mode provides easy access to BoostSpeed sections recommended as a must for anyone

My PC


This is your quick link to detailed information about your system,
including hardware specs, OS and major software. Click it whenever
you need the specs, such as when talking to tech support or looking
to upgrade hardware parts.

My Store


Auslogics BoostSpeed 13

The link to the Auslogics Store lets you access more useful software
from Auslogics and its partners, review information on each program
and download installers. Full versions of the recommended programs
may require license purchase.

My Questions


This link takes you to the Ask a Question tab, which will be described
further in this guide.

Here you can Activate Automatic Maintenance so you can forget
about it and let BoostSpeed monitor your system and take action.
My Advisor takes you to a tab that houses recommended actions you
may want to take to improve your PC’s state. This tool is especially
useful to those who like to find new ways to boost their computers,
as it will give you ideas on what to do next every time you open
BoostSpeed.

My Tools


This link takes you to the All Tools tab where you can find the full list
of all tools included in BoostSpeed. Click it whenever you need to
quickly find and open a specific tool.
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Program Modes: Advanced Mode

Auslogics BoostSpeed 13

To the upper-right of the main Scan
button in Basic mode, you will find
the switch that will take you to
Advanced mode. Another way to get
there is by going to View -> Switch to
Advanced Mode in the main program
menu.
After reviewing all the information
presented on this screen, you can
move on to the full system scan right
from here by clicking the ‘Start a
System Scan’ button (this will open
the My Scanner tab and let you
choose the categories to check before
launching the scan).

When in Advanced mode, you get a
lot more options listed on your
Dashboard.

Get brief info about your PC and
software at the top with a link to
detailed system information.
See a quick overview of your
questions and answers status, or click
to access the Ask a Question feature
(described further in this guide).
Some of the options here are the
same as in Basic mode (see detailed
information earlier in this guide).

18
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In Advanced Mode, you can
customize the tabs that you see at the
top by adding or removing them as
you like. To add tabs, click on the +
sign and select the pages or tools you
want added from the drop-down list.

To remove a tab, simply click the X sign
on it, just like you would in a web
browser. This way you can set up the
Dashboard just the way you want with
the tools you’ll use most often.

To Contents
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BoostSpeed Tabs
Let’s look at the Pages that can be set as tabs. Pages are screens that have multiple tools and options listed on them by categories, so you can have all related tools at hand when
you need to accomplish a specific task

Auslogics BoostSpeed 13

My Dashboard

Comes in 2 versions: Basic and
Advanced, as described earlier in this
guide.
My Scanner

This is the tab you switch to when
you need to customize the scan
categories and review scan results.
You can also launch the scan or
repair from here by clicking the Scan
All or Resolve All button at the
bottom of the page. (See more
information on the My Scanner tab
earlier in this guide).

My Advisor

This tab contains recommendations for
actions that you may want to take right
now to improve your PC’s performance,
speed and security. Select what you
want to do on the left, then look through
the recommended actions and tweaks in
the main part of the window.

Click the button next to any
recommendation you decide to proceed
with.

To Contents
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Ask a Question

Auslogics BoostSpeed 13

On this tab you can ask online experts your questions related to using Auslogics software or to getting your PC fixed and optimized.

To use the feature, you need to get
registered by providing your email
address and a display name. To do
that, click on the ‘Sign up’ button. In
the window that pops up, enter your
name or a nickname you’d like to be
identified by on forum pages, then
your email address, and hit the
‘Register’ button.

Once logged in, click on a category
name for your question, which will
open a form that will let you fill in
your question details.

Once you click the ‘Register’ button,
go to your Inbox at the address you
specified in the form and look for a
confirmation message with your
automatically generated password.
You will need to use that password to
log in when you go to ask your
question. Return to BoostSpeed and
click the ‘Sign in’ button to continue.

On the right, find the latest questions
posted by users through the Ask a
Question tool. Clicking on the ‘Read
now’ link will take you to the
question on the Auslogics forum,
where you can read the answers and
browse other questions.

To access the forum, click the ‘My
account’ button or use the link that
was emailed to you with your
password.

In the lower part of this screen, you
see links to the most common help
topics.
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Submitting Your Question

Auslogics BoostSpeed 13

This form opens once you select a category for your question under the Ask a Question tab.

Select the subcategory for your question topic, type in a descriptive
subject and write your question in the big blank field. You can also use
the ‘Add file’ option to add screenshots or other files to provide more
information on the issue you are having. When done, click the ‘Send’
button. Your question will be reviewed and posted on the web forum,
and you will be able to log in and view answers to your question there
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All Tools
The All Tools tab lists all of the apps that
are included in BoostSpeed, dividing them
into performance categories:
System tools let you run maintenance
and optimization on your Windows
system.
Disk tools provide multiple ways to clean
your PC, defragment and maintain your
disk drives.

Auslogics BoostSpeed 13

Internet and Browser tools help improve
connection speed and get online content
to load faster.
Security tools help protect your personal
information and secure your PC from
threats.
Info tools allow you to get and review
information about your system and
different aspects of its operation.

To find out what a tool does or how it
works, hover your mouse over it to bring
up a hint. Click on a tool to launch it, and it
will open as a new tab in BoostSpeed.
You can also access the tools listed here
through the Tools menu at the top of the
main program window.
You have seen many of these tools
recommended under other relevant tabs
throughout the program, but they are all
listed here in one place to make it
convenient for you to find the tool you
need when you are looking to complete a
specific job.
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Most popular tools

Auslogics BoostSpeed 13

Out of the 20+ tools in BoostSpeed, the following are user favorites

To Contents
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Disk Defrag
This is the Auslogics Disk Defrag that has been loved by users worldwide for over 14 years

You may also click the arrow on the Defrag button and select the operation you want to run: just
Analyze the drives to see the fragmentation percentage, run a regular defrag, optimize your SSD
drive using a special SSD-safe algorithm, run the Defrag & Optimize feature to help prevent
fragmentation, or run a quick defrag without analyzing the drives.

Auslogics BoostSpeed 13

The defragmenter in BoostSpeed is one of
the fastest on the market, with exclusive
algorithms that are safe for your drives.
When you click on Disk Defrag under All
Tools, it will open in a new tab and display
the list of all drives in your computer
system.
Check the boxes next to the drives you’d
like to scan and defragment. Clicking the
Defrag button will first run a scan of the
selected drives, then defragment them, if
defragmentation is needed.

In the center, you see the cluster map which you can use to get information about the location of
files and file pieces on your drives. When defragmentation is running, you can watch the clusters
being moved and files being put together on this map.

25

Below the cluster map you can review detailed information on the selected drive,
including information on files, the drive’s S.M.A.R.T. status and other details.

Auslogics BoostSpeed 13

This is where you can get alerted to hard drive problems and prevent data loss that may
occur due to drive failure.
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Startup Manager
This tool lets you review the applications set to run on system bootup and disable any that don’t necessarily need to be on the Startup list. This can significantly speed up
Windows loading.

When you click on Startup Manager
under All Tools, it will open as a new
tab and display a list of all
applications that have been added to
the Startup list.

Auslogics BoostSpeed 13

To disable an app, just click the
toggle in front of the app’s name.

Click the ‘Google it’ link above the list
to search the web for information on
the selected startup item.
You can select an app and see its
trust rating, publisher name and
some other details below.
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Uninstall Manager
With this tool, you can review all software installed on your computer, select the
apps you’d like uninstalled and remove them one at a time or in batches.

Auslogics BoostSpeed 13

Using the tool is quite intuitive – just check the boxes next to the apps you want
removed and click ‘Uninstall’, or ‘Multiple uninstall’ if removing several apps.
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File Recovery
This powerful undelete tool lets you bring back files you may have deleted by accident, or files that disappeared in a virus attack. It uses a smart algorithm to scan your drives for
previously deleted data and get the files you need restored

To run a search, set the search location(s)
and criteria first (go through 4 steps in
setting the filters).
When done with the search setup, click
the Search button to look through the
“free” space on your drive(s).

Auslogics BoostSpeed 13

Note that the sooner you act after
discovering the file loss, the better your
chances of getting all the data you need
recovered. Your deleted files are only
recoverable until they get overwritten with
new data.
When the search completes, you can look
through the results, preview certain file
types (like pictures or documents) and
select the specific files you’d like restored.
Use the filter at the top to narrow down
the results, check the files you want and
click ‘Recover Selected’ above the list.
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Add-ons Manager
This tool lets you review information on installed browser extensions, plugins and add-ons, application add-ons and shell extensions. Identify unneeded ones and turn them off
with just a click.

Select an add-on to view information
about it below the list.

Auslogics BoostSpeed 13

Click the toggle in front of the addon name to enable or disable it.

If an add-on’s rating is unknown or
you aren’t sure if it’s needed, use the
‘Google it’ link above the list to
search the web for information about
the selected add-on.
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Menu Manager
This newly enhanced tool is meant to help you customize your Windows experience by adding convenient shortcuts to right-click menus throughout the system.

With Menu Manager, you can add or
remove options from the context
menu (right-click menu) for objects
like files, folders, drives, the Recycle
Bin, etc.

Auslogics BoostSpeed 13

Click the toggle in front of each
option to add it to the right-click
menu or remove it.

Hover your mouse cursor over the i
symbol to preview the menu for each
object type.
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Windows Slimmer
If you are running a heavy Windows version on your computer, like Windows 10 or 11, then Windows Slimmer is the tool you may want to use before others. It lets you get rid of
the “filler” the operating system comes with, as well as the unneeded system-related items that may accumulate over time.

The tool deletes demo content, old
WinSxS libraries, disabled Windows
components, unneeded Windows
update files, old system restore
points, etc.

Auslogics BoostSpeed 13

When you click on Windows Slimmer
under All Tools, the tool will open
with the One-Time Maintenance tab
active by default.

Choose a category (select one
cleanup category at a time for best
results) and click on ‘Start Scan’.

Auslogics BoostSpeed 13

32

After the scan completes, you will be
able to review the results and take action
as needed. BoostSpeed will not delete
anything without you clicking the ‘Start
Cleanup’ button.
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When done with the One-Time
Maintenance, click on Regular
Maintenance in the left-side menu and
choose the sections that may be cleaned
up on a regular basis.

Auslogics BoostSpeed 13

You can have Windows Slimmer scan
and clean up memory dumps, CD/DVD
burning cache, the Recycle Bin,
temporary folders and application logs.
Just check the categories and click on
‘Start Scan’.

Auslogics BoostSpeed 13

34

The third feature in Windows Slimmer’s
left-side menu is ‘Compact OS’. The tool
lets you pack up system files to reduce
the amount of space they take up on
your drive. The feature is especially
useful when your OS is installed on a
smaller SSD drive which tends to run
out of space.

If your system drive has plenty of space available, we recommend having the Compact
OS feature disabled to help your system access those files faster.
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Registry Cleaner
Auslogics Registry Cleaner is one of the safest tools of this type available today. Instead of trying to locate as many problematic entries as possible, the tool finds the items that
can be tweaked or removed with no risk of damage to the system.

Auslogics BoostSpeed 13

Open the tool from under the All Tools tab, select the
entry types you’d like to scan (or keep the default
sections checked) and click on ‘Scan Now’
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When the scan completes, you will
see a list of categories with the
number of issues found in each.

Auslogics BoostSpeed 13

You may click on the category name
to see more details on what’s been
detected in it.

Uncheck any items you don’t want
removed (if there are such items) and
click on ‘Resolve’.
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Duplicate File Finder
This is another tool that can help free up gigabytes of disk space. File duplicates can accumulate over time, so cleaning them out should be part of the maintenance routine.

Open Duplicate File Finder by going
to All Tools -> Disk Tools.

Auslogics BoostSpeed 13

Select the drives you want to search,
the duplicate types and set other
search criteria by clicking ‘Next’ to go
through the available options.

When done, click the Search button.

When the search completes, you will see a list of all detected file duplicates divided into groups (each group highlighted with color).
38

You can look through the duplicates and check the copies you want deleted one by one.

Auslogics BoostSpeed 13

However, the easier alternative is to click
on ‘Options & Settings’ in the left-side
menu and choose an option that will let
you select duplicates in batches.

Or you can click the arrow on the
‘Select’ button below the list and
choose an option from the dropdown menu that appears.
When done selecting, click the
‘Delete Selected Files’ button below
the list, or click the arrow on this
button and choose how you want
the duplicates deleted.
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Advanced Mode Tabs

Auslogics BoostSpeed 13

When you are in Advanced mode, you see more tabs available at the top of your BoostSpeed window. Those extra tabs, displayed in Advanced mode only, include:

Auslogics BoostSpeed 13
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Optimize
The Optimize tab gives you the tools and
options you need to ensure the most
efficient and productive Windows
operation.

Auslogics BoostSpeed 13

In the first column, you can select drives
to defragment and click the button to
launch defragmentation. If using Windows
10 or 11, you can also run version-specific
optimization by clicking the Windows
10/11 Protector link here.
The second column gives you quick
access to task-specific modes you can
enable to boost your Windows for
whatever you are doing at the moment.
You can turn on Game Mode when you
want to play computer games, Office
Mode for working with documents and
productivity apps, Economy Mode to save
battery power, or a Custom Mode that you
set up yourself. Click the ‘See details &
customize’ tile to review and adjust mode
settings.

The third column lets you review current
resource statistics and enable real-time
speedup tools: Memory and Processor
Optimization, Auto Defrag, Disk Priority
Manager and Desktop Protection. Each of
these tools optimizes resource
consumption and ensures the best speed
for the applications that are active at the
moment. We recommend keeping these
tools enabled at all times to help things
run faster on your PC.
Right below the mode tiles, you will find
additional tools for optimizing your OS.
You can run additional Windows tune-up
using the Maintain Windows option, or
get rid of unneeded application add-ons
via the Windows 10/11 App Cleanup link.
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Clean up
The Clean Up tab gives you quick
access to all BoostSpeed features
related to system cleanup. Let’s take
a look at your options displayed on
this screen left to right:

Free up even more space using the
third column: here you can uninstall
unused software, including apps that
are hard to remove or may leave files
behind.

In the first column, you can select
the drives you’d like to clean, then
choose the tool you want to use for
cleanup. Selected drives are
highlighted in green with the green
checkmark at the top-right.

The fourth column lists BoostSpeed
tools that can help clear disk space.
Most of these are already linked to
from the previous columns, but they
are still listed here for your
convenience.

The second column provides quick
access to tools designed for cleaning
and tweaking your Windows registry
and system folder
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Protect

Auslogics BoostSpeed 13

The Protect tab helps you secure personal
data and activity history saved on your
computer. Traces of your credit card and other
financial info, passwords 
stored openly in files, history of website visits,
video views and other data you may want to
keep private is actually quite easy to retrieve
from your PC, if it ever gets in the wrong
hands. We recommend running a scan for
privacy traces and cleaning them up on a
regular basis (from once a week to once a day,
depending on how heavily 
you use your PC).
On the left side, you see the four areas
that can be checked for privacy traces. If
you’d like to have one or more of them
ignored during scans, just uncheck the
‘Include category’ box next to it to
exclude it.
Сlick the ‘Scan now’ button below the 
category list to launch a quick scan for
privacy traces.

On the right, you get to control your web
browser and protect it from unauthorized
changes using the Browser Protection tool.
Just enable the tool by flipping the switch
here.
Right below this feature, you see some
recommended tools that help protect
your confidential files and guard your
Windows system from hackers.
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When the scan completes, review the
results by clicking the ‘Check Details’ link
next to each category, and remove all
traces to protect your privacy. If needed,
you will be able to exclude some of the
detected items from the cleanup by
simply unchecking the boxes next to
them.

Auslogics BoostSpeed 13

When done, just click the ‘Resolve all
items’ button to get all of those privacy
traces removed and your personal data
protected.

NOTE

The tools you see recommended
under the Clean Up, Optimize and
Protect tabs can also be found
under the All Tools tab: that’s where
you can quickly access any tool you
need without having to look for it
under different tabs.
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Maintain
In addition to the more common optimization features we have looked at earlier in this Guide, BoostSpeed gives you even more control over your Windows system by checking
every corner of it for potential tweaks that could be applied to improve security, stability and speed.
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The Maintain tab lets you run a check for such
potential tweaks, review the suggestions and
apply any you want your PC to benefit from.
BoostSpeed will look for tweaks under
Performance, Stability, Security and
Internet categories. Once a scan
completes, you will most likely get a long
list of personalized recommendations,
which may include hardware tweaks or
other similar tweaks that need to be
applied manually, as well as a number of
tweaks you can have BoostSpeed apply
automatically on your behalf. Review each
tweak and uncheck any that you aren’t
sure about, then click the ‘Apply all
selected tweaks’ button to have
BoostSpeed go through the tweaks one by
one.

Cat Mode (see next page for info)

Right below Cat Mode, you get shortcuts
to some useful system maintenance tools.
Further down is a feature that will come in
handy if you need to boost your other
computers without having to install
BoostSpeed on them. You can simply
create a portable version of BoostSpeed,
save it on a flash drive and use on other
PCs in your household. This is especially
useful when you want to run maintenance
on a computer that is running out of disk
space and has no room for installing other
software. Now you can get every PC in
your home to run great and help your
family enjoy their computers too. Keep in
mind that if you want to use BoostSpeed
Portable for commercial purposes, you will
need to purchase a license.
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Do you have any pets in your home who might like hanging out next to or on your desk? Then you
will love the Cat Mode feature designed to protect your computer from pet-caused accidents.
When active, the mode gets your keyboard (and your mouse, optionally) locked when you are away
from your PC, which lets your cat safely rest on your keyboard, play with your mouse or try to type
any messages without risking that you’ll get upset at the result. The accidents this helps prevent can
be real disasters, as reported by many pet owners who have lost important data or lost access to
their computers because of something their pets did.
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Here is how the tool works.
Click on the ‘Settings’ link to set the time that should pass without any
activity on your PC, after which the mode gets enabled. You can also
choose whether you want your mouse buttons to be locked in addition to
the keyboard; choose the combination of keys that must be pressed to
turn the mode off and set other options. When done, click the ‘OK’
button.

To disable the mode when you return to your PC, just
click the combination of keys you have set for Cat Mode
to require. If you have forgotten it, don’t worry: your
screen will show you a prompt whenever your PC gets
locked by BoostSpeed.

Now, you can hit the ‘Activate’ switch whenever you are about to step away
from your PC, or have it active at all times, so it will get turned on once your
PC has been idle for the amount of time you specified.
NOTE

If you set the idle time to 1 minute, you may see Cat Mode get enabled when you are reading a large article on screen or looking through some other info without touching your keyboard or mouse for
over a minute. However, setting it to 5 minutes or longer may result in your cat jumping on your PC’s keyboard before the mode gets a chance to protect it. A good solution would be to set the time to 1
minute, but have the mode enabled every time right before you step away from your PC instead of keeping it on all the time.
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Reports
When running maintenance or optimization
on your computer, it is important to be able to
see the results you are getting. The Reports
tab gives you just that, as well as lets you see
when maintenance may be needed.
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On the left side of the screen you can
monitor current resource use statistics.
This provides a great overview of how your
system is handling all the tasks and
applications that are currently running on
it. If you see extremely high CPU, disk,
network or memory loads, you will know
that something might be wrong and will
be able to take action by using the Clean
Up and Optimize tabs.

On the right side you see a table that lists
reports created after every operation. You
see the report name, the name of the tool
that created it and the date when the
operation ran. Filters above the table let
you search for specific reports by creation
time and tool name. Click on a report in
the table to select it, then click the ‘View
report’ button below the table to view it.
Use the ‘Delete’ button to delete all
reports ever created or just the reports
listed above (the ones that match your
search filters): you can select the option
you want from the drop-down menu that
opens when you click on the ‘Delete’
button arrow.
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Scheduling Maintenance: Automatic Defragmentation
BoostSpeed lets you schedule regular maintenance for hands-off cleanups and tune-ups. This helps keep your PC running fast and smooth for you continually.

Choose how often you would like to run
defragmentation and which drives you’d like
BoostSpeed to defragment automatically.
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To schedule tasks, click on the clock icon at
the bottom-right of the main program
window.
A window will open on the ‘Disk Defrag’
tab, where you can set up a schedule for
automatic defragmentation of your
computer drives.

You can also enable other options here to
prevent defrags from interfering with your PC
use. Set BoostSpeed to create a report after
every automatic defrag, if you’d like. You will
be able to see brief statistics on previous
defrags right here below all options.
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Scheduling Maintenance: My Scanner
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The ‘My Scanner’ option in scheduler
settings lets you set up automatic scans
for actionable items under Disk Space,
Stability, Performance, Disk Defrag,
Privacy, Internet Speed and Windows 10
Tweaks – the functionality that you run
manually using the My Scanner tab in
BoostSpeed’s main window. Having
BoostSpeed run these tasks automatically
on a regular basis frees up your time and
helps ensure smooth PC performance
without requiring you to do anything
manually.

To schedule tasks, click on the clock icon at
the bottom-right of the main program
window.

Select the categories you want included in the regular scan and repair (you can click the arrow
next to category name and select specific subcategories only, if you like).

Now specify the time that’s convenient for
running maintenance. It’s best to set a
time when your PC is usually on, but you
are not using it very heavily. Click OK
when done.
NOTE

The My Scanner schedule includes
options for running Disk Defrag and
Privacy scans, which can also be set up
separately from the respective tabs in
the Scheduler’s left-side menu.
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Scheduling Maintenance: Privacy
In addition to junk file cleanup and
performance optimization, you can have
BoostSpeed run regular cleanups of
privacy traces using the ‘Protect’ option in
scheduler settings.

Just like you did when scheduling My Scanner,
here you can click on the arrow next to the
word ‘Privacy’ to expand the list of
subcategories, and check or uncheck them as
needed. Then choose the frequency and
convenient time for your regular cleanups and
click OK when done.
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Having traces of your private data, including
credit card and banking info, cleared from
various locations on your PC helps ensure that
this information will never get in the wrong
hands.
To access privacy cleanup scheduling options,
click on the clock icon at the bottom-right of
the main program window.
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Program Settings: General
Although BoostSpeed works great on default settings, it also offers extensive customization options, so you can enjoy a program that looks and works exactly as you want it.

Here you can set the program to launch on PC
startup to ensure that it monitors performance
and runs optimization in the background as
needed. You can also choose which
notifications BoostSpeed displays and switch
BoostSpeed scanners into advanced mode by
enabling system-critical categories here.
To access BoostSpeed Settings, click on the
gear icon at the bottom-right of the main
program window.
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This will open the Settings window on the
General tab.

This is also where you tell BoostSpeed
whether you want browser cookies deleted on
every cleanup. Keep this box unchecked if you
want to keep the cookies and prevent various
sites from requiring you to re-log in every time
you visit them.
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Program Settings: View
The View menu lets you customize the program’s appearance.

Computer screens may have different
resolution, and BoostSpeed allows adjusting
the size of interface text and elements to
better fit the resolution on your PC.
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To access the View settings, click the gear icon
at the bottom-right of the main program
window. Then select the ‘View’ tab from the
left-side pane.
There are 3 sub-sections under View,
which let you customize the program’s
general appearance, as well as the
appearance of the Duplicate File Finder
and File Recovery tools.

The other options in the General view settings
let you choose how CPU temperature should
be displayed and whether heavy resource
consumers should be marked in red.
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In the View settings for Duplicate File
Finder you can set whether and how you
want to preview detected duplicates, and
if you’d like to include hidden folders in the
search.
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The View settings for File Recovery let you set
whether removable drives and SSDs should
be displayed and available to the tool. You can
also choose if you want to preview
recoverable files and which files should not be
previewed.
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Program Settings: Integration
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BoostSpeed lets you integrate some of its
features and options into various system
menus. This allows you to right-click on
items and run BoostSpeed operations on
them without having to actually open
BoostSpeed. Go to the ‘Integration’ tab to
do that.

To open Settings, click on the gear icon at the
bottom-right of the main program window.

For instance, if you choose to integrate Disk
Defrag into context menus, you will then be
able to right-click on a folder in File Explorer
and defragment that folder. You can also set
Disk Defrag as your default defragmenter, add
the “Unlock File”, “Recover Files” and “Shred
Files” options to drive and Recycle Bin menus.
The integration is seamless, but is easy to
undo anytime you want.
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Program Settings: Notifications
When running tasks or monitoring
system status, BoostSpeed shows
notifications in your system tray
(bottom-right corner of your
computer screen).
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You can disable notifications by
checking the ‘Don’t show this again’
box on the popup message, or do it
in the settings.

The Notifications section in program
settings is where you can choose which
notifications you want to see in the tray.
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Program Settings: Ignore Lists
BoostSpeed’s scanners and some
tools have Ignore Lists you can add
objects to when you want them
excluded from scans and cleanups.
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When working with each of these
tools, you have the option to add
items to exclusions as you go.
However, you may find it convenient
to handle the Ignore Lists from the
program’s main Settings window, as
it lets you see all of the exclusions
you have set or can set.

Under Ignore Lists you see the subsections for Scanners (the features you
use under the My Scanner tab in
BoostSpeed’s main window), Disk
Defrag, Duplicate File Finder and File
Recovery. Click through them and follow
the on-screen instructions to add or
remove items.
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Program Settings: Other
Additionally, BoostSpeed lets you
customize the way it handles files
and set additional options for various
tools and features.

Scroll down the left-side pane to see
the settings for Cat Mode and
Rescue Center (both covered earlier
in this Guide).

You can have the program wipe junk
files being deleted to prevent their
recovery. You can also specify regular
folders that you want cleared during
cleanups (just make sure none of
their contents are important, as they
will be permanently deleted).

The last option is ‘Language’, which
lets you choose the interface
language for BoostSpeed.

Some tools use algorithms that can
be further customized and finetuned to fit your individual needs:
just click the tool in the left-side
pane and make your selections.

When done adjusting settings, be
sure to click the OK button to apply
the changes.
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Contacting Auslogics
Many of the questions you may have
regarding Auslogics products have
already been answered in the FAQ
section on www.auslogics.com
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The Support section on the Auslogics
website also offers a way to retrieve
a lost license code, request a refund,
download product manuals and
more.

Should you have any questions that
are not answered on the website,
you can ask Auslogics experts using
the ‘Ask a Question’ tab in
BoostSpeed, or email our dedicated
customer support team 24/7 at
support@auslogics.com
Our mailbox is monitored and emails
are answered 24/7, and we try to
respond to all inquiries within 24 to
48 hours.

Thank you for using

